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O AV:AN=IZ@WE Expert Visualizer Basics

You can use the ForeView RMON ST application suite to configure, manage, and display statis-
tical information collected from a variety of agents, switches, and frame-relay links. Expert
Visualizer is the tool you can use when you want to see all this information, from a large num-
ber of devices, in a single screen.

Expert Visualizer features powerful 3-D display capabilities that let you not only view agents
and segments on your network, but also let you size the visual display based on variables
such as utilization, bytes, or errors. Using the 3-D display capabilities, you can quickly and
easily focus on specific areas using other available tools.

You can zoom in on selected portions of your network based on various RMON parameters
such as collisions, utilization, packets, broadcasts, and errors, among others. The size of each
screen object indicates the intensity of the selected statistic at that location. The number of
lines connecting the objects indicate the intensity of network traffic between segments or hosts
across the entire enterprise network.
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When you want to examine a portion of a network in more detail, you can launch ForeView
RMON ST Manager diagnostic tools such as Segment Zoom, Host Zoom, and others directly
from Expert Visualizer. For information on these features, see the ForeView RMON ST User’s
Manual.

You can use Expert Visualizer to graphically display information about your network for a
single agent, a frame relay agent, an agent group, or a switch. Visualizer also provides an
interface to ForeView RMON ST tools that you can use to focus on problem areas, resolve prob-
lems, and even view trend analysis and print data.

When working with switches, Expert Visualizer
m> lets you see all ports. The collection of ports on a
switch are an implicit agent group. Although the
ports on a switch aren’t classified as an agent

group in the ForeView RMON ST main window,
they are in fact a group.
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Expert Visualizer Basics

1.1 Working with Visualizer modes

In Expert Visualizer, you can choose from three different display modes: Traffic Monitor,
Internet Monitor, and Application Monitor. These modes let you evaluate your network in
terms of physical, logical, or application traffic as follows:

- Traffic Monitor. Helps you troubleshoot physical layer network problems. The
information is taken from the data-link layer and maps onto the basic RMON
standard supporting any RMON-compliant agent or probe. Traffic Monitor pro-
vides information relating to performance, topology, and traffic patterns for one
or more segments.

Traffic Monitor runs in Basic, Frame Relay, or Switch mode, depending on what
you select from the ForeView RMON ST main window list boxes (agent, frame
relay agent, agent group, or switch) before launching Visualizer. Traffic Monitor
intelligently launches the correct application, depending on what you choose to
monitor.

Regardless of whether your network is a switched environment or contains WAN
frame-relay circuits or shared/legacy LAN traffic, you can use Traffic Monitor to
view traffic, just as you would in a less complex network. The beauty of the appli-
cation is that the interface you work with in all modes is identical, yet Traffic
Monitor does all the background work for you, gathering useful statistics without
additional configuration. Even though there are multiple applications running in
the background, the only difference you’ll see when you run different Traffic
Monitor modes is the application name on the title bar of each window in the
GUI. The modes available are Basic mode, Frame Relay mode, and Switch mode.

For more information about the different
M} Monitor types and the Views available with

each, see Changing Views on page 3-3.

< Internet Monitor. Helps you troubleshoot logical network problems with infor-
mation taken from the network layer and maps onto the RMONZ2 standard. Visu-
alizer can display information from any RMONZ2-compliant agent or probe.
Internet Monitor provides information related to subnetworks and enterprise net-
work-layer traffic patterns and performance for a variety of network layers
including IP, Novell, DECnet, Vines, and Appletalk.
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Internet Monitor operates only in conjunction

m> with an RMONZ2-compliant agent or probe. It is
not supported by the FORE Systems’ LAN
switches.

< Application Monitor. Helps you troubleshoot application-level problems for
applications such as Notes, cc:mail, and Sybase, among others. The information is
derived from ForeView RMON ST extensions for Domain View and Enterprise
RMON and the application-specific group of RMONZ2. Application Monitor pro-
vides information about application traffic and usage patterns throughout an
enterprise network. You can customize the set of applications participating in the
Application Monitor.
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Application Monitor will not function properly

m> or produce useful data unless it is used in
conjunction with a NETscout Probe. For
information on NETscout Probes, please contact
the FORE Systems TAC (Technical Assistance
Center).

1.1.1 About Different Agent Types

Before launching Visualizer, you can select a normal agent, a frame relay agent, or a switch.
When you select a frame relay agent, you’ll be able to see DLCI information for the selected
network segment. When you select a switch, you’ll be able to see all the ports on it. The ports
are an implicit group. Keep in mind that the tools available for further drill-down and prob-
lem resolution may differ, depending on the type of agent you select before launching Visual-
izer.

ForeView RMON ST™ Expert Visualizer User's Manual 1-3



Expert Visualizer Basics

1.2 About RMON2

RMON2 support is necessary when you need to monitor and troubleshoot at layers higher
than data link. With ForeView RMON ST’'s RMONZ2 functionality, you can monitor traffic at
network and application layers. You now can get statistics for all hosts accessing a specific seg-
ment, no matter where the hosts are located, or how the network is connected.

The PowerHub LAN switches contain mini-
M} RMON or Roving RMON groups, but do not

support RMONZ2 in the 4.2 software release.

With RMONZ2, RMON groups map into all of the major network layer protocols, such as IP,
IPX, DECnet, Appletalk, Vines, and OSI. You can monitor application layer traffic, so you can
monitor network applications such as Notes, Telnet, Microsoft Mail, and Sybase. You can do
this because RMON2 outlines how you can construct logical filters for remote agents. ForeView
RMON ST can now monitor and help you troubleshoot key application layer traffic within the
enterprise network.

Both ForeView Expert Visualizer and ForeView RMON ST are built in the framework of the
RMON standard and provide tools that are structured for easy migration to the upcoming
RMONZ2 standard.
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Expert Visualizer Basics

1.3 Chapter Summaries

This manual is organized into five chapters that contain the information you need to work
with all of ForeView Expert Visualizer’s capabilities. The following chapters are included in
this book:

Chapter 1: Expert Visualizer Basics - Introduces the ForeView Expert Visualizer.
Chapter 2: Getting Started - Tells you how to get started with Visualizer.

Chapter 3: Using ForeView Expert Visualizer - Discusses Visualizer basic functions and tells
you how to use them.

Chapter 4: Using and Customizing Views - Describes Visualizer Views and tells you how to
use them.

Chapter 5: Troubleshooting with Expert Visualizer - Tells you how to use Visualizer as a
powerful starting point for troubleshooting your network.
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Appendix A: Visualizer’s Configuration File - Contains the config.vis file listing.

Appendix B: Color Applications and X-Window Displays - Describes color applications and
the X-window display.
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Expert Visualizer Basics

1.4 Document Conventions

This section illustrates and describes all the conventions used throughout the manual. Take a
look now, before you begin using this book, so that you’ll know how to interpret the informa-
tion presented.

1.4.1 Using a Mouse

Throughout this book, we provide mouse instructions based upon use of a three-button
mouse. If you’re using a two-button mouse, you can generally press and hold down both the
left and right buttons to simulate the middle mouse button’s actions on a three-button mouse.

1.4.2 Understanding Different Fonts

When you’re using this book, you’ll notice that some words look different. The table below
explains what the differences in word appearance mean.

When you see this: It means you must: For example:
Commands in Bold type a command or some| typesetenv
(may be used with other con- | other element, as shown.
ventions)
Words within text in a san- | Commands, Menu selections,
serif font. such as File/Run, or file $HOME/ust/dvinst.cfg

names that appear within text
of this manual.

Bold field names, headings,
and other bold words

field names, section names
within a window, list box
names, variables, and special
emphasis.

Command button example:
Click on the Edit button.

menu selections in a different
font, such as Edit/Reset... or
File/Print

select the first menu item
shown, then select the next
item specified.

Select Size By/Utilization

less-than
symbols.

Words within the
and greater-than
(<>)

Words representing function
keys on the keyboard. Press
the specified key.

Press <Enter>

press and hold the
<Shift>+<Ctrl> keys to...

Words shown in bold within
the less-than and greater-than

provide a filename, path, or
system variable; however, do

Specify the <install_path>:
HOME

symbols not type the symbols!
(<>)
1-6 ForeView RMON ST™ Expert Visualizer User's Manual
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1.5 Text Notes and Graphics

Text notes are always set off by one of the three terms that follow in the examples below. When
you see these terms, you’ll know what kind of information to expect from the related text
notes.

This is the text note. A text note provides
M} references to other areas of the manual or other
documentation for supplementary information,

as well as interesting information that’s related
to, but different from, basic text.

CAUTION This is the Caution text note. A caution text note
provides information you need to know to
prevent operations problems with system
hardware or software.
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WARNING! This is the Warning text note. A warning text
note provides extremely important information
you must read to prevent damage to the system
hardware, or to the person operating the
hardware.
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1.6 Procedures

Procedures begin with a feature description, followed by step-by-step, numbered instructions.
When procedures require you to supply user-defined information, refer to the table in Under-
standing Different Fonts on page 1-6.

The following paragraphs show how procedures are displayed.
1. Numbered steps tell you what action to take.
2. Numbered steps may give you options, as shown below:

- Option 1 and criteria required.
or

- Option 2 and criteria required.

1.6.1 SampleWindows

In this book, all the sample windows you’ll see show a white background with differently
shaded gray objects displayed. The Visualizer screens you’ll see when you launch the applica-
tion are actually differently colored objects displayed upon a black screen. However, to ensure
that the screens are as useful as possible in this manual, we’ve inverted the colors so you can
see the objects, labels, addresses, and other graphical elements clearly.
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1.7 Technical Support

In the U.S.A., you can contact the FORE Systems TAC (Technical Assistance Center) by any
one of the following four methods:

1. If you have access to the Internet, you may Contact the FORE Systems TAC via E-
Mail at the following Internet address:

info@fore.com

2. You can access the FORE Systems Web Page at:
http://www.fore.com

3. You can send questions via US mail to the following address:
FORE Systems
1000 FORE Drive
Warrendale, PA 15086
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4. You can telephone your questions for support to:
1-800-671-FORE
Non-U.S. customers can get support through their local distributors.

When contacting the FORE Systems TAC, please be prepared to provide information such as
your support contract license humber, your serial numbers of the products, and as much
information as possible describing your system configuration and your problem or question.
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1.8 Related Documentation

ForeView RMON ST User’s Manual

If you’re running ForeView RMON ST on a UNIX platform, the ForeView RMON ST User’s Man-
ual is the reference manual you’ll use.

1.9 Installing Visualizer

If you installed the ForeView Expert Visualizer application when you installed ForeView RMON
ST, then you should skip this section and proceed to Chapter 2: Getting Started. ForeView
Expert Visualizer has been installed if there is an icon labeled “Expert Visualizer” in the main
window of ForeView RMON ST.

Before installing ForeView Expert Visualizer, make sure that you have installed the ForeView
RMON ST application. ForeView Expert Visualizer is an add-on application and requires
ForeView RMON ST.

To install ForeView Expert Visualizer, use the following procedure.

1. Login as root user.

2. Insert the ForeView 4.2 CD in the CD-ROM drive and mount the file system as
/cdrom, using the appropriate device name and mount command for your OS.
See the documentation for your OS for more information.

3. Switch to the UNIX directory on the CD-ROM by typing the following:
cd /cdrom/unix
4. Launch the installation script by typing the following command:
Jinstall

5. Follow the directions in the install script to install ForeView Expert Visualizer.

After the installation is complete, start ForeView RMON ST by changing to the
/ust/fore/foreview/bin directory and typing the following command.

Jfvrmon
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OV SISl Getting Started

2.1 Introduction

In this chapter you’ll learn how to start Visualizer, as well as get familiar with how to work
with the menus.

2.2 Starting Visualizer
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Visualizer is invoked from the ForeView RMON ST main window.

2.2.1 Starting Visualizer from ForeView RMON ST

To start Visualizer from the ForeView RMON ST main window, use the following procedure.

1. Start ForeView RMON ST as described in the ForeView RMON ST Manager User’s
Manual. The ForeView RMON ST Manager main window is displayed, as shown in
Figure 2.1 on page 2-2.
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File Application Tools  Help

Agents [All] Agent Groups Switches
Hew Mew HMew
ﬂl Edit I Edit I
\.ﬁil View I View I
Delete| Delete | Delete |
[rest ] team |
Show 4 all o S

Filter Darmain

Editar Eclitor

Figure 2.1 - ForeMiew RMON ST Manager main window

2. Define and select the agent, agent group, or switch you want to
view in Visualizer. Keep in mind that although you can use Visu-
alizer with individual agents, it’s really most useful when you
launch it for an agent group or a switch.

3. Click on the Visualizer icon shown in the ForeView RMON ST main
window.

The Expert Visualizer main window (Figure 2.2 on page 2-3) is dis-
played. The display you see differs, depending on whether you
selected an agent, group, or switch before launching the
Visualizer.
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2.2.2 Understanding the Visualizer Main Window

When you start Visualizer, the Visualizer main window (Figure 2.2) is displayed. The default
view is Traffic Monitor, Segment View. Note that in this view, different network segments are
shown as different shapes and colors. Segment view details are provided in Chapter 4.

Tools

Menu bar > Hie Monitor  View Edit  Select Size By Sample Option

Ethernet
segment
(@)
@
g.
(@]
Token Ring g
ment =
>3 — @ 2
Marked
[ wan103 WAN
g - segment

Ethemet @ Fast Ethemet Token Ring FDDI WAN ATHM

Figure 2.2 - Traffic Monitor, Segment View window

The rest of this manual describes each view, as well as viewing and troubleshooting your net-
work.
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2.3 Working with Menus

When you’re working with Visualizer, you’ll use the items on the menu bar often. For fre-
guently used menus, a shortcut is detaching menus. When you detach a menu, it remains
open, and you can drag it anywhere on the display to a convenient spot. For example, if
you’re using the Size By menu to customize elements in a view, you can open, detach, and
move the menu so that it’s easily accessible as you’re working.

2.3.1 Detaching Menus

When you detach menus, manipulating the views is faster because you don’t have to con-
stantly open and close the menus you want. Detached menus update automatically as neces-
sary, depending on the selections you make.

Whenever you want to detach a menu from the menu bar, use the following procedure.

1. Click on the menu you want to detach from the menu bar.

2. Using your middle mouse button, click and hold while you drag the opened menu
off the Visualizer window and move it to a convenient spot elsewhere on your
desktop.

3. The menu you selected is opened and detached from the menu bar, although the
name of the menu is still displayed on the menu bar.

4. Repeat Step 1 and Step 2 for as many menus as you want to detach.

The Visualizer window displays all the menus
m> you detached. Figure 2.3 on page 2-5 shows what
a window with all menus detached looks like.
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Figure 2.3 - Visualizer window with all menus detached

2.3.2 Reattaching Menus

To close and put a menu back on the menu bar, just click on the menu name (on the menu bar)
of the detached menu. When you do so, the menu you detached earlier closes and moves back

to the menu bar.
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2.4 Sample Windows

As you work with Expert Visualizer, you’ll see many different types of windows, depending
on the views, tools, agents, groups, or switches you select. To give you an idea of what to
expect, this section contains several sample views.

If you select Traffic Monitor and Segment View with labels, you’ll see a window similar to the
one shown in Figure 2.4.

Hie Monitor  View Edit  Select Size By Sample DOption Tools

dR_56

<‘J_Lu:lnlllii

Ethemet @ Fast Ethemet Token Ring FDDI WAN ATHM

Figure 2.4 - Traffic Monitor window, Segment View,
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If you select Traffic Monitor and Host View with labels, you’ll see a window similar to the one
shown in Figure 2.5.
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Figure 2.5 - Traffic Monitor window, Host View
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If you selected Traffic Monitor, Topology View with labels, you’ll see a window similar to the
one shown in Figure 2.6.

Hie Monitor  View Edit  Select Size By Sample Dption Tools

rnSof-01-0c-73

isco 0 rnSof-01-0e-d5
esc —70-30-80 BH -bl1-94-e2
nSof-01-09-70 FrnSof-01-0b-1

nSof-21-07-5a rnSof-01-05-66

C

-b6-0d4-19
nSo 11

-38-fe-bd

Ethemet Fast Ethemet Token Ring WAN

RING Size by:<NOTHING> Ready

Figure 2.6 - Traffic Monitor window, Topology View
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If you selected a switch before launching Expert Visualizer, the first window you’ll see is simi-
lar to the one shown in Figure 2.7. Notice that in this view, each port on the selected switch is

labelled.

Hie Monitor  View Edit  Select Size By Sample DOption Tools
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Figure 2.7 - Switch window, Segment View,
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Visualizer

This chapter tells you how to use Visualizer basic functions. Later chapters provide more
detailed information on Visualizer Views and on network troubleshooting using Visualizer.

3.1 Changing the Sample Time

You can select how often Visualizer samples selected elements. The default sample time is 1
minute. To change the sample time, select Sample from the menu bar and then select the sam-
ple time you want.
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3.2 Selecting Visualizer Monitors

Visualizer lets you select one of three monitors (Traffic, Internet, or Application). The monitor
you select affects the view (views are described in detail later in this manual). Monitors and
RMONZ2 are described in Chapter 1. In this section, you learn about views, labels associated
with each monitor, and how to select a monitor. Monitor selections you can choose include:

< Traffic. The default monitor, which lets you select any view at any time. It works
on all segments for Segment View and for selected segments in the Host View and
Topology View.
The Host View is clustered based on agent name if you’ve selected more than one
segment. The segment labels available from the Traffic Monitor are:

- Segment View. Shows agent hame and IP address.
- Topology View. Shows host name and MAC address.
- Host View. Shows host name and MAC address

For the Topology View, you can only select one segment, and that segment must
be either FDDI or Token Ring.

In Traffic Monitor and Application Monitor, the
m> Host View is clustered by agent name, if more

than one segment is in use.
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< Internet. The Internet Monitor works on all segments in the Segment View. You
can select the Host View while you’re in the Segment View.

- Segment View. Shows agent hame and IP address.
- Host View. Shows host name and network address.

< Application. The Application Monitor works on all segments for the Segment
View and for selected segments in the Host View. The labels available from the
Application Monitor are:

- Segment View. Shows agent name and domain name like this:
agent: domain

- Host View. Shows host name and address.

To select a monitor, select Monitor from the menu bar and then click on the monitor type you
want.

Internet Monitor and Application Monitor
m> requires a NETscout Probe.

3.2.1 Monitoring Specific Protocols

In addition to selecting a monitor,the Internet Monitor enables you to select the protocol you
want to monitor. Protocols you can select include the following:

- [P

= |PX

= DECNET
= VINES

= ATALK

To select a protocol, from the menu bar select Monitor, then select the protocol you want to
monitor from those shown in the group at the bottom of the menu. Keep in mind that the
Internetwork Monitor defaults to IP. To change this default setting, you must edit the con-
fig.vis file. For more about the config.vis file, see Appendix A.
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3.3 Changing Views

This section presents a summary of Visualizer views. Views are discussed in detail in Chapter
4. The View menu changes dynamically when you change the Monitor. The View menu selec-
tions are as follows:

= |fyou’ve selected the Traffic Monitor:
- Segments
- Topology - Token Ring and FDDI only
- Hosts
= Ifyou’ve selected the Internet Monitor:
- Segments
- Hosts
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- Ifyou’ve selected the Application Monitor:

- Segments
- Hosts

CAUTION When you change monitors, the view always

defaults to Segments.

3.3.1 Rotating Views

Visualizer views are three-dimensional. You can look at any view from different perspectives
by rotating it. When you do so, you select what portions of the view are most interesting to
you and rotate them to the foreground of the display.

To rotate any view, just hold down the middle mouse button and move the mouse—keep in
mind that the faster you move the mouse, the faster the view rotates. For automatic rotation
(autorotation), press <Ctrl> and then press the middle mouse button as you move the mouse.
To stop autorotation, press the middle mouse button again. If you want autorotation at a
higher speed, when you start autorotation, move the mouse faster.
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3.3.2 Zooming Views

Zooming is a useful tool that lets you focus on different elements in the Expert Visualizer dis-
play. If you want to see the “big picture,” you can adjust the application to show as many ele-
ments as possible, so you can see how they relate to each other. However, if you want to focus
on just one element, you can adjust the application to show only that one element, and the
other components of the picture drop out of your view.

Relating the binoculars example to Expert Visualizer, if you want to see all the elements that
represent your network, you would zoom out. While the display window does not change
size, you'll notice that the elements within the display, the elements that are part of the view,
do get smaller to accommodate as much of the view as possible while you zoom out.

If there’s a specific element of the view that you want to look at more closely, you would zoom
in on that element. Again, doing so changes only the size of the elements on the display.
Therefore, when you zoom in on an element, it gets larger and the elements around it drop out
of the view. Whenever you want to zoom in or out in a view, use the following procedure.

1. Press and hold the <Shift> key and the middle mouse button.
2. Do one of the following;

- If you want to zoom in to the view, move the mouse up.
or

- If you want to zoom out of the view, move the mouse down.

3.3.3 Panning Views

The pan tool complements the zoom tool. You can pan left, right, up, or down. After zooming
in on a view, you can then expand it to see any elements that now don’t fit in the display. For
example, if you’ve zoomed in on an element of your network and you notice that a key ele-
ment isn’t shown, you might use the pan tool to find it. Because the display window showing
the view you select is fixed, once you’ve zoomed in on an element other network, elements
just don’t fit in the display window. Pan helps ensure that you see the whole network picture.
To use pan view any time, use the following procedure.

1. Press and hold the <Ctrl> key and the left mouse button.
2. Move the mouse to pan the view. You can move the mouse up, down, left, or right.

3.3.4 Restoring Default Views

Whenever you’ve zoomed in or out of a view, or when you’ve used the panning tool, you can
easily restore the original default view by just selecting Edit/Reset from the menu bar.

3-4 ForeView™ RMON ST Expert Visualizer User's Guide



Using ForeView Expert Visualizer

3.4 Selecting Elements

You select elements so that you can see them in detail or change them in some way, such as
hiding them, hiding other elements in the view, and marking them, among others. Whenever
you select an element, the color changes to off-white, making it easy for you to tell what
you’ve selected.

Keep in mind that when you select an entity, its
M} color changes to off-white. Off-white is also the
same color as labels, so you might not be able to

see a label on an entity you select. If this occurs,
rotate the view until the label is displayed.
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You manually can select one or more elements at any time. Selecting elements is very useful
when you want to isolate part of your network and examine it in more detail. Selecting spe-
cific elements is especially useful if there are many elements shown in a view, and you only
need information about a few of those shown. There are two methods you can use to select
elements:

< Manual element selection. To manually select an element, click on it with the left
mouse button. If you want to select more than one element manually, press and
hold the <Shift> key and click on the elements you want.

= Automatic menu element selection. You can choose to select all elements shown
in a view. To do so, from the menu bar, choose Select/All. Keep in mind that this
method of selecting elements does select all shown; you cannot pick and choose
as you can with the manual element selection method.

To deselect elements, choose Select/None from the menu bar. When you do so, all the ele-
ments are deselected and the correct colors are displayed.

3.5 Showing or Hiding the Legend

For each view you select, Visualizer offers a legend you can use to quickly identify what
shapes shown on the display represent. Using the legend, you can identify at a glance all
Ethernet elements in your network.

Visualizer shows the legend by default, although you can toggle it on and off. To turn the leg-
end on or off, just select File/Show Legend from the menu bar.
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3.6 Viewing Network Elements by Size

The key to troubleshooting with Visualizer is the Size By selection on the menu bar. When you
choose the Size By menu, you can then select any of the listed variables, such as utilization
and packets in. When you select a variable, the view changes size, depending on the variable
you selected. You can tell what’s happening in your network by looking at the relative sizes of
different elements in the view.

The Size By menu offers different variables for different view. Size By defaults to utilization
when you select Segment View and utilization out when you select either Host View or Sub-
net View. For more about sizing, see Chapter 5, Troubleshooting with Expert Visualizer.

3.7 Updating the Display

The information that Visualizer uses comes from one or more agents at periodic intervals. All
data is accumulated before it is displayed. If you don’t want to wait for all the data to be col-
lected, you can use Update Display to show partial data.

Keep in mind that the Update Display tool isn’t designed to work with the Size By option.
Size By works only when all data objects have arrived. However, you can use Update Display
to get an immediate display based on partial data objects.

3.8 Using the Right Mouse Button

You can use the right mouse button as a shortcut to making selections from the Tools menu.
Please keep in mind, however, that it’s context sensitive.

3.9 Printing Views

Any time you want, you can print the view displayed. To do so, use the following procedure.

1. With the view you want to print shown in the display window, select File/Print
from the menu bar to display the Print window.

2. Select the print options you want, then click on OK to print the view.
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3.10 Exiting Visualizer

To exit the Visualizer at any time, just select File/Exit from the menu bar.
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This chapter presents the Expert Visualizer views and describes how you use them. It also
describes how you can customize views to suit your needs.

4.1 Labelled Segments

As described in Chapter 3, Visualizer lets you label segments according to the type of segment
and the monitor you’re using. To see an example view showing labels, see Figure 4.1 on page
4-2.
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Figure 4.1 View with labels

4.2 Segment View

Segment View, the default view, shows all network segments. Different segments are denoted
by graphic objects of different shapes and colors. Figure 4.2 on page 4-3 shows a typical Seg-
ment View with segment labels.
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Figure 4.2 Segment View (default view)

To make sure that you understand what the different shapes and colors for elements mean, see
Table 1 on page 4-4. When you select a view using Visualizer, you’ll note that each element in
the network is represented by a unique shape and color combination. The only exception to
the unique shape and color rule is that the blue color and cube shape are used for the Host
View displayed through the Internet Monitor. Host view is independent of the physical net-
work topology. All objects belong to a particular agent; their colors and shapes are derived
from the agent type.
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Table1l Element Identification

This network element: Is shaped like this: And is this color:
Ethernet Cube Blue
Fast Ethernet Cube Green
WAN Star Blue
ATM Star Green
Token Ring Buckyball Blue
FDDI Buckyhball Green
Unresponsive agent Square, 2-D Red
Responsive agent, with no|Shape derived from Red
domain present agent type and speed
Agent (Topology View) No change Yellow
Selected elements No change White
Conversation lines (Host View) | Lines with 5 grades of| Yellow

thickness

4.3 Host View

The Host View shows the traffic between hosts in a selected segment. The traffic between
hosts appears as lines of varying thickness. The thicker the line, the higher the volume of traf-
fic. To get a Host View, use the following procedure.

1. While in Segment View (the default view), select one or more segments.
2. From the menu bar, select View/Hosts.

)

Host group is not one of the mini-RMON
groups, and so is not supported on the
PowerHub 7000. It is supported in a limited
fashion on the 3810 with Roving RMON. If you
select View/Hosts from the menu bar when
examining a segment on the PowerHub switch,
the segment will appear, but no traffic will be
shown.
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Visualizer pauses a short time (sometimes up to a few minutes) as it gathers and organizes the
host information you requested. Then the Host View (Figure 4.3 on page 4-5) is displayed.
Notice that the lines between the hosts vary in thickness, indicating different volume levels of
traffic between the hosts.
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Figure 4.3 Host View
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4.4 Topology View

The Topology View is only used for Token Ring and FDDI networks because this view shows
ring structure that’s unique to these two ring-based topologies. The Topology View is not sup-
ported on the FORE Systems LAN switches without a separate network probe. To see an
example of the Topology View display, see Figure 4.4.
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Figure 4.4 Topology View
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4.5 Working with Views

Visualizer offers different views so you can select the one that you need for different situa-
tions. However, there might be times when you want to further customize a view to empha-
size certain aspects of network performance. For example, if you're tracking end-of-month
traffic volume levels on the segment containing hosts used by the finance and accounting
departments, you might want to isolate only those hosts and the lines indicating the traffic
volume. To do so, you would customize a view by isolating and labelling only the hosts used
by finance and accounting.

4.5.1 Customizing Views with the Edit Menu

The Edit menu is especially helpful when you want to adjust how network elements are dis-
played in a view. To do so, use the following procedure.

1. With the elements you want displayed in the view of your choice, select the ele-
ments you want to change.

2. To change the selected elements in the view display, from the menu bar select Edit
and any of the menu selections you need as described:

Mark. Mark selected elements for easy identification.

Isolate. Isolate selected elements, meaning that these selections are the only
elements displayed in the view.

Hide. Hide selected elements, meaning that these selections are not displayed
in the view. These elements are not deleted, but are only hidden.

Expose. Redisplays all hidden elements, as well as those you manually
selected to be hidden.

Reset. Resets the display to the default view.

4.5.2 Labelling Elements in Views

You can also choose to label elements displayed in a view. To do so, choose Edit/Show Labels
from the menu bar. Once you do so, you then can select either of the following label types:

< Show Names. Displays the names of selected elements.
< Show Addresses. Displays the addresses of selected elements.
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4.6 Using Visualizer with Non-NETscout Probes

The Internet Monitor and Application Monitor do not present useful data with non-NETscout
probes because these monitors rely on NETscout’s Domain View features. Traffic Monitor
works with NETscout Probes and other RMON-compliant switches and probes.
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O AV:ANSIZgN Troubleshooting with Expert

Visualizer

This chapter explains how to use Expert Visualizer as a first step in troubleshooting your net-
work.

5.1 Recommended Troubleshooting Methodology

When you want to Troubleshoot with Visualizer, we recommend using the following methods
(shown in order).
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= Run Expert Visualizer and create a view showing the network elements in which
you’re interested. As described in Chapter 4, you can customize the view to show
only selected elements.

= Use the Size By menu, described in this chapter, to quickly determine the level
network activity among the selected elements.

e Use the Expert Visualizer Tools menu to investigate selected elements more
closely using ForeView RMON ST tools directly.

5.1.1 Using Size By Options

On the menu bar, choosing Size By helps you customize elements in a view. This is useful
when you want a view to stress how different elements relate to each other and the selected
segment. To use Size By options, use the following procedure.

1. Select the view you want. You may want to hide or isolate certain elements.

2. From the menu bar, select Size By, then select the parameter that corresponds to
how you want the elements sized.

5.1.1.1 Sized View Example

Different Size By options are available for different views. These options are described in the
sections that follow. Figure 5.1 on page 5-2 shows an example view sized by a certain variable.
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Hie Monitor  View Edit  Select Size By Sample Dption Tools
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Figure 5.1 - Example of sized view

5.1.1.2 Using Size By Options with Traffic Monitor
This section describes the Size By options available on each view from the Traffic Monitor.

51121 Segment View

The Size By options corresponding to the Segment View are:
= Utilization (default)
= Packets
= Broadcasts
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= Multicasts

= Small Packets
= Large Packets
= Collisions

= Errors

51122 Topology View
The Size By option corresponding to the Topology View is Ring Order.

5.1.1.2.3 Host View
The Size By options corresponding to the Host View are:
e |n Util
e Out Util (default)
= In Packets
= Out Packets
< |In Bytes
e OQOut Bytes
= Broadcasts
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e Multicasts
e Errors

5.1.1.3 Using Size By Options with Internet Monitor

Using the Internet Monitor requires a Netscout
m} probe.

This section describes the Size By options available from the Internet Monitor.

51131 Segment View
The Size By options corresponding to the Segment View are:

= Utilization (default)
= Packets
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5.1.1.3.2 Host View
The Size By options available in the Host View are:
e In Util
= Out Util (default)
= InPackets
= Out Packets

5.1.1.4 Using Size By Options with Application Monitor
This section describes the Size By options available from the Application Monitor.

Using the Application Monitor requires a
m> NETscout Probe.

5.1.14.1 Segment View

The Size By options corresponding to the Segment View are:
= Util (default)
= Packets

5.1.1.4.2 Host View
The Size By options corresponding to the Host View are:
e |n Util
= Out Util (default)
* In Packets
= Out Packets

5.2 Using ForeView RMON ST Manager Tools

When you have viewed your network using Visualizer, you can immediately zero in on a seg-
ment using one or more of ForeView RMON ST’s tools. In this way, you isolate a network prob-
lem and quickly get more detailed information about it. The ForeView RMON ST tools you can
choose (by selecting Tools from the menu bar) are specific for each view. The listing below
specifies which tools you can select for each view. For complete instructions on using tools, see
the ForeView RMON ST User’s Manual.
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5.2.1 Using ForeView RMON STTools with Traffic Monitor

This section describes the tools available on each view from the Traffic Monitor.

5.2.1.1 Segment View Tools
The tools corresponding to the Segment View are:

< Domain Manager

= Remote Login

= Segment Zoom

< Top N Talkers

= Statistics Graph

= Short-Term History Graph
< Long-Term History Graph
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= Trap Manager

5.2.1.2 Topology View Tools
The tool corresponding to the Topology View is Ring Monitor.

5.2.1.3 Host View Tools
The tools corresponding to the Host View are:

= Trap Manager
= Data Capture
= Host Zoom

5.2.2 Using ForeView RMON ST with Internet Monitor

This section describes the tools available from the Internet Monitor.

Using the Internet Monitor requires a NETscout
m} Probe.
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5.2.2.1 Host View Tools
The tools available in the Host View are:

< Trap Manager

= Data Capture (for IP Internetwork Monitor)

e Host Zoom

5.2.3 Using ForeView RMON ST with Application Monitor

This section describes the tools available from the Application Monitor.

)

5.2.3.1 Segment View Tools

The tools available in the Segment View are:

= Segment Zoom
e Top N Talkers
= Trap Manager

5.2.3.2 Host View Tools

The tools available in the Host View are:

= Host Zoom
= Trap Manager

Using the Application Monitor requires a
NETscout Probe.
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In this appendix, you’ll see the default config.vis file (Visualizer’s configuration file). You will
need to edit this file whenever you change Visualizer’s parameters.

Anything preceding a colon (?) is a keyword. You
m> cannot change keywords. In the following

example trafficlimit is a keyword.

trafficlimit: 2

Anything following a colon (?) is a variable and
can be changed. In the above example, the 2 is a
variable.

The following is an example of the config.vis file:

# ForeVi ew Expert Visualizer configuration file.
#

# This is the netmask value which will be used in creating
# subnet vi ews.

#

net mask: 255.255.255.0

# The default net which will be sel ected when the Internet
# nonitor type is chosen.

#

defaultnet: ip

s.Jaziensip
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# Limt the nunber of segnents which can be sel ected when
# noving tothe Host/ Subnet view(s) for each nonitor type.
#

trafficlimt: 2

internetlimt: 2

applicationlimt: 2
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# Define the donains which will be used for the Traffic nonitor views.
#

traffic-segment: ALL

traffic-host: ALL

traffic-topol ogy: ALL

# For each network type (ip, ipx, vines, dec, and atal k) specify
# the donmmins for each view type (segnent, subnet, hosts). If

# a network or viewtype is omtted, it will not be shown.

# However, the 'segnent' view cannot be renoved w thout

# renoving all ofthe other views for that nonitor as well.

#

i p-segnent: | P

i p-subnet: | P-SNET

ip-user: IP

i px-segnment: NOVELL
i px- subnet: NOV- SNET
i px-user: NOVELL

dec-segment: DECNET
dec-subnet: DEC- SNET
dec-user: DECNET

vi nes-segnent: VI NES
vi nes-subnet: VI NESNET

vi nes-user: VI NES

at al k- segnment: ATALK
at al k- subnet: ATLKSNET
at al k-user: ATALK

# Specify the application nonitor domain names.
#

application-segnent: | P NOVELL DECNET
application-user: | P NOVELL DECNET
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# Specify donain nanes which should not be clustered.
#
not clustered: |P-SNET NOVELL NOV- SNET VI NESNET DEC- SNET ATLKSNET

s.Jaziensip
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X-Window Displays

Sometimes when running color-intensive applications like ForeView Expert Visualizer, your
X11 display might flash or show unusual colors in some windows. This appendix explains
how application software such as ForeView Expert Visualizer, your X-windows server code,
and the system hardware interact to manage the use of color.

B.1 About System Limitations
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Today's color workstation displays typically have just one megabyte of image memory. At
high resolution, one byte of storage is available per picture element (pixel) to store color infor-
mation.

Although people can distinguish among literally millions of different colors, one byte stores
only 256 different color values. To get around this problem, a special "map" is used so that the
X-window server can create a limited palette of 256 different colors from a much larger total
color space (typically about 16 million colors).

The X server cooperates with user-level software so that the 256 color map locations can be
shared among all applications running.

B.1.1 When Your System Runs Out of Colors

You might think that 256 different colors is quite a lot to be using at one time, but remember:

= A Motif widget uses at least five colors: one for each chiseled side, one for the top,
and one for the label.

< The window manager (OpenLook, Vue, and mwm, among others) uses another
set of colors for the screen background, icons, and window decorations. On some
vendors’ systems, the window manager alone can require more than 60 different
colors.

< |Ina3-D window, each object color actually uses eight or more different shade lev-
els to give depth to the display.

=« Showing any kind of GIF, TIFF, and other graphics formats can use up one or two
hundred colors quite easily.

= Applications generally can’t share colors except under special circumstances.
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As you can tell from the bullets above, it's pretty easy to run out of colors with even only two
graphics applications open. What happens when the system has run out of available colors
depends on the behavior of each individual application.

Some applications just refuse to run, and indicate that no colors are available. Other applica-
tions may switch to a black-and-white mode. Most graphics programs try to cope by creating
what's known as a “private color map”—essentially, a new set of 256 colors supplied by the X
server software.

Since there is still really only one hardware color map, to do this, the X server swaps the hard-
ware color map contents whenever you go into or out of such a privately held window. There-
fore, all of the other applications now seem to be using an alien set of colors, and the display
might look strange, with the exception of the window in the privately held applications. If you
move back out of the private window, it looks peculiar while the rest of the display returns to
normal.

B.1.2 Conserving Color

There’s no way to remove the hardware-based 256-color limitation or to change X11 behavior;
so the only way to prevent this kind of color map flashing is to conserve colors. Techniques
you can use include:

< Do not display scanned images. Displaying a scanned image in a window, or on
your screen background, can use up all available colors very quickly. Exit the
application that is doing image display while you need to run other color-inten-
sive tasks.

= Configure the window manager. Some window managers, like HP Vue, let you
configure color usage. If this is available, try to configure it for "low" or "medium."”

< Work around X11 bugs. Some versions of X11 (including the one distributed with
SunOS 4.1.3) do not always free color map entries properly. Therefore, your sys-
tem may appear to have very few colors available even though no other applica-
tions are running. The only thing to do in this case is to exit the window manager
(log out) and restart the X11 server. The new server will have a fresh, empty color
map.

= Start ForeView Expert Visualizer last. If you need to run a few color applications,
start ForeView Expert Visualizer last because it can adapt itself to a smaller num-
ber of available colors. When you start Visualizer first, it tries to improve the
image quality by taking more colors if it can.

B.1.3 Color Limits in ForeView Expert Visualizer

Visualizer only allows seven distinct colors to be used in its 3-D displays. Seven isn’t exactly a
magic number; it just simplifies the look of the display. The fewer number of colors, the easier
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it is to take in at a glance.

Also, to let you move the 3-D display quickly, Visualizer uses a technique called color map
double-buffering. This technique requires eight color map locations for each color displayed
because some colors (the “invisible” ones hold the part of the display that the computer is
painting while others provide a stable, visible display while motion is being computed.)
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